
MS Word 2007 
 

 

 

  

Budget Management Tools 
In Banner 



  

 

 

 

 

 

 
(Intentionally left blank) 

 



 

SLCC Banner  

Budget Management Tools in Banner 

Budget Management Tools in Banner   Page i 
Office of Information Technology  February 2016 

Table of Contents 

Introduction: .................................................................................................................................. 1 

About this Document .............................................................................................................................. 1 

Confidentiality of Data ........................................................................................................................... 2 

Section I:  Managing Budgets using Banner Forms ................................................................... 3 

Primary Banner Forms Used ................................................................................................................. 3 

FGIBSUM ............................................................................................................................................... 4 

Organization Budget Summary ............................................................................................................................ 4 

To use FGIBSUM: ........................................................................................................................................ 5 

FGIBAVL ................................................................................................................................................ 6 

Budget Availability Status ................................................................................................................................... 6 

To use FGIBAVL: ......................................................................................................................................... 7 

FGIBDST ................................................................................................................................................. 9 

Organization Budget Status Form ........................................................................................................................ 9 

To use FGIBDST: ....................................................................................................................................... 10 

To see detailed account activity for a selected Account: ............................................................................ 13 

FGITRND .............................................................................................................................................. 14 

Detail Transaction Activity ................................................................................................................................ 14 

To use FGITRND: ...................................................................................................................................... 15 

To see more detail about a specific transaction: ........................................................................................ 17 

For encumbrance information: .................................................................................................................. 18 

FGITBAL .............................................................................................................................................. 19 

General Ledger Trial Balance ............................................................................................................................ 19 

To use FGITBAL: ....................................................................................................................................... 19 

To see more detail about a specific transaction: ........................................................................................ 20 

FGIGLAC ............................................................................................................................................. 22 

General Ledger Activity ..................................................................................................................................... 22 

To use FGIGLAC: ...................................................................................................................................... 23 

Section II:  Generating Reports................................................................................................... 25 

Generating a Banner Report ............................................................................................................... 25 

To Generate a Report in Banner:........................................................................................................................ 26 

To View the Generated Report: ......................................................................................................................... 29 

Printing the Report: ............................................................................................................................................ 30 

Section III:  Budget Reports ........................................................................................................ 32 



 

SLCC Banner  

Budget Management Tools in Banner 

Budget Management Tools in Banner   Page ii 
Office of Information Technology  February 2016 

FGRBDSC – Budget Status (Current Period) Report ...................................................................... 32 

FGRBDSC Parameter Table .............................................................................................................................. 32 

Sample of FGRBDSC Report ............................................................................................................................ 34 

FGRODTA – Organization Detail Activity Report ........................................................................... 35 

FGRODTA Parameter Table .............................................................................................................................. 35 

Sample of FGRODTA Report ............................................................................................................................ 37 

FGRGLTA – General Ledger Transaction Activity Report ............................................................ 38 

FGRGLTA Parameter Table .............................................................................................................................. 38 

Sample of FGRGLTA Report ............................................................................................................................ 39 

Report Printing Tips ............................................................................................................................ 40 

Further questions or clarification contact: ......................................................................................... 40 

Appendix A:  Index Code Logic .................................................................................................. 41 

Basic Rules: ........................................................................................................................................... 41 

General Fund Indexes (hard funded indexes) ..................................................................................................... 41 

Revenue Indexes (soft funded indexes).............................................................................................................. 41 

Appendix B:  Account Code logic................................................................................................ 42 

Appendix C – Accounts for Chart of Accounts ........................................................................... 43 

Appendix D – Banner Form Naming Matrix ............................................................................. 50 

Appendix E:  Transaction Types and Document Number Definitions ...................................... 55 

Commonly Encountered Transaction Types ...................................................................................... 55 

Document Numbers .............................................................................................................................. 56 

Appendix F:  Creating Macros in Word 2013 ............................................................................ 57 

What is a Macro? .................................................................................................................................. 57 

Instructions for Creating a Macro: ..................................................................................................... 57 

Step 1 – Display the Marco Recording Button .................................................................................................. 57 

Step 2 - Create a Record Macro Button ............................................................................................................. 58 

Step 3 - Begin Recording the Macro .................................................................................................................. 61 

Sample Formatting for a Banner Budget Report .............................................................................. 61 

 



  



 

SLCC Banner  

Budget Management Tools in Banner 

Budget Management Tools in Banner   Page 1 
Office of Information Technology  February, 2016 

Introduction: 

About this Document 

Budget Management Tools in Banner is a reference manual used to: 

 explain Managing a Budget Using Banner Forms: 

 FGIBSUM – Organization Budget Summary 

 FGIBAVL – Budget Availability Status 

 FGIBDST – Organization Budget Status 

 FGITRND – Detail Transaction Activity 

 FGITBAL – General Ledger Trial Balance 

 FGIGLAC – General Ledger Activity 

 generate Banner Reports: 

 FGRBDSC - Budget Status (Current Period) Report 

 FGRODTA - Organization Detail Activity Report 

 FGRGLTA - G/L Transaction Activity Report 

 print Banner Reports 

It also contains in the appendices: 

 Index Code Logic 

 Account Code Logic 

 Account for Chart of Accounts 

 Banner Forms Naming Matrix 

 Transaction Types and Document Number Definitions 

 Creating MS Word Macro Instructions 

 

Hyperlinks:  This document contains underlined words or phrases that indicate a 

hyperlink.  Press the Control key on the keyboard and at the same time click on the 

hyperlink.  The document will open to the location referred by the link. 
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Confidentiality of Data 

Banner accesses data stored in the Salt Lake Community College (SLCC) 

administrative database.  Some of that data is protected by privacy laws 

and should only be accessed within the parameters of job requirements.  

Upon logging in to Banner, an individual’s username sets data access 

restrictions.  However, confidentiality of data should always be paramount 

in the mind of Banner users.  In addition, federal law dictates what student 

data can be released to outside entities.  FERPA (Family Educational 

Rights and Privacy Act) is a federal law that establishes student 

information privacy: what can legally be released, and under what 

conditions.  A prerequisite for access to Banner is to successfully FERPA 

training.  You can register for this training by going to MyPage and 

selecting the Employee Training channel.  This training teaches Banner 

users what and when data may be released according to FERPA.  For 

further information about FERPA contact the SLCC Registrar Office, 957-

4799. 
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Section I:  Managing Budgets using Banner Forms 

Primary Banner Forms Used 

There are primarily six Banner forms used to manage an organization’s budget.  The 
table below lists these six forms along with their general description and a brief 
explanation of function or use. 

 

Form Name General  Description Function or Use 

FGIBSUM 
Organization Budget 

Summary 

High level summary of budget by 4 
Account Types: 

Revenue, Labor, Expenditure, and 
Transfer. 

FGIBAVL 
Budget Availability 

Status 
Budget availability for a selected Index 

Code and Account Category combination. 

FGIBDST 
Organization Budget 

Status 
Budget availability by Organization Code 

and Account Code combination. 

FGITRND 
Detail Transaction 

Activity 

Detailed transaction activity by account 
code. 

Displays each transaction for a given 
account code. 

FGITBAL 
General Ledger Trial 

Balance 

Trial balance for each fund for 
all accounts, account types, or account 

codes. 

FGIGLAC 
General Ledger 

Activity 
Detailed transaction activity for General 

Ledger accounts by account code. 
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FGIBSUM 

Organization Budget Summary 

This form provides a quick and easy, high-level view of the organization’s available 
budget by major category.  Use it to view summarized budget information by user-
defined account type for a selected organization and/or fund. 

It contains four lines summarizing the budget and YTD transactions by: 

 Revenues 

 Labor 

 Expenditures 

 Transfers 

The form does not have an Index code field.  The user must know the Fund or 
Organization code to use this form. 

 

 

  

Key Block 

Transaction 
Block 
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To use FGIBSUM: 

Key Block 

Chart of Accounts: and Fiscal Year:, 
are required fields. 

Banner populates the Chart of 
Accounts field.  No change required. 

Fiscal Year will display the current fiscal 
year.  Enter the desired Fiscal Year or 
leave as is. 

 

 

 

There is no Index code field.  Enter the 
Organization and/or Fund code. 

Select Next Block to execute the query. 

 

 

 

Transaction Block 

Budget information is displayed in four 
lines summarizing the budget and YTD 
Activity totals by: 

 Revenues 

 Labor 

 Expenditures 

o Current Expense 

o Capital Equipment 

o Travel 

o Budget Holds 

 Transfers 

Note:  For more detail, access form 
FGIBDST from the Options menu. 

 

 

 

  



 

SLCC Banner  

Budget Management Tools in Banner 

Budget Management Tools in Banner   Page 6 
Office of Information Technology  February, 2016 

FGIBAVL 

Budget Availability Status 

Form FGIBAVL displays budget availability at the pooled expense budget line level 
as of the current system date.  It reflects: 

 current budget 

 YTD expenditures 

 current commitments 

 available budget 

For example, the “current expense budget” is recorded in account 70000.  All current 
expense transactions and outstanding encumbrances are accumulated and subtracted 
from the current expense budget resulting in a remaining balance. 

Note:  This form only deals with expenditures; therefore, no revenue budgets will 
appear. 

 

 

  

Key Block 

Transaction 
Block 
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To use FGIBAVL: 

Key Block 

Chart, Fiscal Year, Index, and 
Account are required fields. 

The Banner system populates the 
Chart field with a C. 

Fiscal Year will display the current 
fiscal year.  Leave this as is or enter 
the desired Fiscal Year. 

 

 

 

Enter the Index Code for the 
organization. 

The Commit Type field defaults to 
Both.  Do not change. 

 

 

 

Banner populates Fund, Organization, 
and Program fields after entering a 
valid Index Code. 

Enter 60000 in the Account field. 

 Retrieves all expense budget 
categories 

Select Next Block. 
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Transaction Block 

For each FOAP, the table displays: 

 Total adjusted budget 

 Year to date (YTD) activity 

 Total commitments 
(encumbrances) on the budget 

 Total budget still available 

Budget information displays by Account 
Categories. 

 Detail account numbers do not 
appear on this form. 

 Refer to FGIBDST for detailed 
activity by account number. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Extracting Data 

Data from this form can be extracted to 
a spreadsheet. 

To do this: 

1. From the Menu Bar, select Help. 

2. From the Help Options, select 
Extract Data with Key or 
Extract Data No Key. 

3. Extracted data is displayed in a 
spreadsheet. 

Note:  Extract Data with Key means 
that the data in the Key Block will be 
included on the spreadsheet. 
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FGIBDST 

Organization Budget Status Form 

 

Form FGIBDST provides a summary of YTD activity by account number for an Index.  
Because SLCC does not budget at a line item or account level, the Available Balance 
column normally shows negative balances.  It is not easy to determine available 
balances using this form.  FGIBDST displays what has actually been completed and 
posted. 

Access other forms directly from the FGIBDST form.  From the Menu Bar, select 
Options and access one of the following forms: 

 FGIBSUM 

 FGIOENC 

 FGITRND 

 

Key Block 

Transaction 
Block 
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To use FGIBDST: 

Key Block 

FGIBDST opens with the cursor in the 
Chart field.  This is defaulted to C.  Do 
not change.  Press Tab. 

Note:  Required field 

 

 

The cursor moves to the Fiscal Year 
field.  This is defaulted to the current 
fiscal year and can be changed. 

Press Tab. 

Note:  Required field 

 

 

The cursor is in the Index field.  Enter 
the Index code for the organization. 

Press Tab. 

Note: After entering a valid Index code, 
Banner populates the Fund, 
Organization, and Program fields. 

 

 

  



 

SLCC Banner  

Budget Management Tools in Banner 

Budget Management Tools in Banner   Page 11 
Office of Information Technology  February, 2016 

The cursor moves to the Query Specific 
Account check box (indicated by 2 
dashed lines).  This check box provides 
3 query options: 

After choosing to check the box or not, 
press Tab. 

 

 

1. Not checking the box and not 
entering an account number in 
the Account field will return all 
accounts with activity. 

 

 

and 

 

2. Not checking the box and 
entering an account number in 
the Account field will return that 
account and all others after it, 
sequentially, that have had 
activity. 

 

 

and 

 

3. Checking the box and entering 
an account number in the 
Account field will return only that 
account if it had activity. 

 

 

and 

 

 

16 
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The cursor moves to the Include 
Revenue Accounts check box 
(indicated by 2 dashed lines).  A check 
appears in the box by default. 

Checked – Revenue Accounts will be 
included in the query. 

Unchecked – Revenue Accounts will 
not be included in the query.  

 

 

Leave the Commit Type field set to 
Both. 

 

 

 

Organization, Fund, and Program 
fields automatically populate after 
entering a valid Index code. 

Account is optional.  (See Query 
Specific Account instructions above.) 

Account Type, Activity, and Location 
are not used. 

 

 

 

Select Next Block to execute the query 
and display the accounting detail. 

Transaction Block 

The cursor will move to the first Account 
record with that record highlighted. 

Use the cursor Up and Down Arrow 
keys to select another Account record. 
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To see detailed account activity for a selected Account: 

Select the desired Account. 
 

 

From the Menu Bar click on Options 
and from the Options Menu, select 
FGITRND. 

 

 

 

The form FGITRND will open with detail 
of activity on the selected Account. 

Closing FGITRND will return to 
FGIBDST. 

For more information on the form 
FGITRND, see the next page. 

 

 

Note:  From the Option Menu, open 
forms FGIBSUM and FGIOENC.  These 
forms will open with data from the 
organization entered in FGIBDST. 
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FGITRND 

Detail Transaction Activity 

 

Use this form to display detailed transaction activity for operating ledger accounts: 

 Revenues 

 Expenses 

 Transfers 

 Related budget entries. 

Run a query to display Information on the form.  Setting the parameters for a query is 
explained below. 

The transaction information displays the FOAP, sorted by Account for posted 
transactions.  Use the horizontal scroll bar to view a transaction’s: 

 Activity Date 

 Type 

 Document 

 Description 

Note:  The Total field displays the total of the positive and negative amounts of the 
records displayed on the form.  Select Options > Query Total for all records to obtain 
the total for all records returned by the query. 

Key Block 

Transaction 
Block 

Transaction 
Block -

Additional 
Detail 
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To use FGITRND: 

Key Block 

COA and Fiscal Year are required 
fields.  The rest of the fields may be left 
blank. 

Entering an Index code or Account 
number restricts what can be queried in 
the Transactions Block. 

For example: 

 Enter an Index code to query only 
accounts from that Index code. 

 Enter an Account number to 
query only transactions on that 
Account. 

 Entering both an Index and 
Account code allows queries 
only on transactions within that 
Index and Account. 

Note: Entering a valid Index code 
populates the Fund, Organization, and 
Program fields. 

Select Next Block. 

 

 

 

 

 

 

 

Transaction Block 

The cursor moves to the Account field 
in the Transaction Block. 

The form goes into Query Mode. 

Enter Query values. 

 

 

All fields in the Transaction Block can 
be queried except: 

 Activity Date 

 Description 

Enter query values in the appropriate 
fields. 

Press F8 to execute the query. 
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Note:  To get a hard copy of this report, 
go to FGRODTA under Printed 
Reports. 

 

 

 

Extracting Data 

Data from this form can be extracted to a 
spreadsheet. 

To do this: 

1. From the Menu Bar, select Help. 

2. From the Help Options, select 
Extract Data with Key or 
Extract Data No Key. 

3. Extracted data is displayed in a 
spreadsheet. 

Note:  Extract Data with Key means 
that the data in the Key Block will be 
included on the spreadsheet. 
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To see more detail about a specific transaction: 

Select the transaction line by clicking 
in any field on the line (selected line is 
highlighted). 

 

 

 

Select Options from the Menu Bar. 

Select Query Document. 

 

 

 

 

 

 

The form that opens: 

 is determined by the transaction 
Type in the transaction line. 

 displays detail information about 
the transaction. 

Note:  Transaction Type definitions are 
located in Appendix E, pg. 55. 
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For encumbrance information: 

Select a transaction line that contains an 
Encumbrance type document. 

Select Options from the Menu Bar. 

From the drop down Options List, 
select Detail Encumbrance Info 
(FGIENCD). 

Note: Use only for transactions with 
encumbrance type documents.  If not, 
“This function is valid only for 
encumbrance type documents.” 
appears in the Auto Hint Line. 

 

 

 

 

 

Form FGIENCD opens. 

This form displays detailed information 
about the selected encumbrance type 
document. 
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FGITBAL 

General Ledger Trial Balance 

 

 

 
Use this form to obtain balance sheet information for all accounts, account types, or 
account codes by requested Fund.  Every account always displays a debit or credit 
balance indicator.  Asterisks display if the account balance differs from the normal 
balance. 

FGITBAL displays Beginning Balance and Current Balance amounts as of the date 
of the query for the balance sheet for the entered Fund number. 
 

To use FGITBAL: 

Chart, Fiscal Year, and Fund are 
required fields. 

Enter a Fund code in the Fund field. 

Entering an Account number is optional. 

Press Next Block. 

 

 

 

  

Key Block 

Transaction 
Block 
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If an Account number was entered, 
information for only that Account and 
Fund will be displayed. 

 

 

 

 

 

If an Account number was not entered, 
information for all Accounts in the Fund 
will be displayed. 

 

 

 

 

 

 

 

 

To see more detail about a specific transaction: 

Select the transaction line by clicking 
in any field on the line (selected line will 
be highlighted). 

 

 

 

 

 

 

 

 

From the Menu Bar, select Options. 

Select Query General Ledger Activity 
Info (FGIGLAC). 
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Extracting Data 

Data from this form can be extracted to a 
spreadsheet. 

To do this: 

1. From the Menu Bar, select Help. 

2. From the Help Options, select 
Extract Data with Key or 
Extract Data No Key. 

3. Extracted data is displayed in a 
spreadsheet. 

Note:  Extract Data with Key means 
that the data in the Key Block will be 
included on the spreadsheet. 
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FGIGLAC 

General Ledger Activity 

 

 

Use this form to view detailed transaction activity for General Ledger (Balance Sheet) 
accounts by account number in an online summary.  The user can perform queries 
using the Account, Type, Document, Amount, and/or D/C fields presented in the 
form. 

 
  

Key Block 

Transaction 
Block 
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To use FGIGLAC: 

Required fields are Chart, Fiscal Year, 
and Fund.  Entering an Index code will 
populate the Fund Field. 

In the Key Block, enter an Index 
number 

Select Next Block. 

 

 

The cursor moves to the Account field. 

Enter a query. 

Note: Executing a query with all fields 
blank, displays all transactions by 
general ledger account (accounts 
presented in ascending order) for the 
selected Index and Fiscal Year. 
 

 

 

 

Fields that can be queried 

Due to the possible high number of 
transaction records displayed, the total 
for all records is not displayed in the 
Total field. 

To display the Total for all records, do 
the following: 

 

From the Options menu, select Query 
Total for all records. 

This displays the last record and the 
total for all records retrieved by the 
query. 
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Extracting Data 

Data from this form can be extracted to a 
spreadsheet. 

To do this: 

1. From the Menu Bar, select Help. 

2. From the Help Options, select 
Extract Data with Key or 
Extract Data No Key. 

3. Extracted data is displayed in a 
spreadsheet. 

Note:  Extract Data with Key means 
that the data in the Key Block will be 
included on the spreadsheet. 

 

 

To see more detail for a specific transaction: 

Select the desired transaction 
record. 

(This highlights the selected record.) 

 

 

 

From the Options menu, select 
Query Transaction Source Info 
(By Type). 

Based on the Transaction Type, a 
form opens that displays transaction 
detail. 
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Section II:  Generating Reports 

Generating a Banner Report 

Banner’s Job Submission Process generates reports from Banner data.  A Job 
Process is created for the desired report.  These Job Processes must be used to 
generate reports from Banner.  Each Job Process has a unique name, i.e., FGRBDSC.  
Requesting a Job Process, opens form GJAPCTL, Process Submission Control 
Form.  Use form GJAPCTL to enter the report parameters. 

 

 

Form GJAPCTL 

  

Key Block 

Printer 
Control Block 

Report 
Parameters 

Block 

Submission 
Block 
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To Generate a Report in Banner: 

From the General Menu Form 
(GUAGMNU) enter the Job Process 
Name for the report in the Go To... 
field, such as FGRBDSC. 

Press Enter. 

 

 

 

Key Block 

Form GJAPCTL, Process Submission 
Control form, opens. 

The Job Process Form name will 
appear in the Process field and it’s 
Description in the field to the right. 

Press Tab. 

 

 

 

In the Parameter Set field, enter or 
select the name of a saved parameter 
set. 

If there is no Parameter Set saved, 
leave this field blank. 

Select Next Block. 

Note: Creation of a Parameter Set is 
explained below. 

 

 

 

Printer Control Block 

In the Printer field, enter DATABASE.  
Leave the other fields blank. 

Select Next Block 
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Report Parameters Block 

 

If a saved Parameter Set was 
entered, the saved values will be 
loaded in the Values fields. 

If no Parameter Set was used, enter 
the appropriate Values for each 
parameter. 

 

To learn what the Parameter Values should 
be and how to enter them, go to the section 
for each report: 

 FGRBDSC 

 FGRODTA 

 FGRGLTA 

. 

Note:  If reading this reference manual on 
line, hold down the Ctrl key and click on the 
desired report. 

 

The Parameter Values entered 
determine the contents and scope of 
the report. 

Select Next Block. 

 

 

Submission Block 

To save the entered Parameter 
Values as a set to use again, click the 
Save Parameter Set as check box. 

Press Tab. 

 

 

In the Name field enter the desired 
name for the Parameter Set. 

Press Tab. 

 

 

 

 

 

In the Description field, enter a 
description of the purpose or contents 
of the report. 

Press Tab. 
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Ensure the Submit radio button is 
selected. 

 

 

 

Click Save or press the F10 key to 
save the report parameters and run 
the report. 

 

    or F10 key 

 

An Alert Box will open stating the 
Parameter Set is saved. 

Click OK. 

 

 

 

The data on the entire form will clear 
indicating the report has run. 

Report information will display in the 
Autohint Line. 
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To View the Generated Report: 

From the Menu Bar select Options. 

From the Options List, select Review 
Output (GJIREVO). 

 

 

 

 

The form, GJIREVO opens. 

The cursor will be in the File Name 
field. 

Double click in this field. 

 

 

 

 

 

The Available Files block opens with 
2 output files: 

 One ending with extension .lis 

 One ending with extension 
.log. 

Double click on the .lis file. 

 

 

 

The report displays in Banner. 
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Printing the Report: 

With the report displayed, select 
Options from the Menu Bar. 

Click on the Show Document (Save 
and Print File) option. 

 

 

 

An Alert Box opens stating that the 
file will open in a browser (your default 
browser). 

Click the Yes response button. 

 

 

 

A Browser window (your default 
browser) will open with the report 
displayed. 

From the Page menu options, select 
the Save As option. 
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The Save Web Page dialogue box 
opens. 

Using the Save in field, navigate to a 
folder in which to save the Report file. 

In the File Name field enter a name 
for the Report file 

In the Save as type field, click the 
Search button and select Text File 
(*.txt) from the drop down list. 

Click the Save button. 

 

 

 

 

After saving the file, navigate to it.  
Right click on it and open it with MS 
Word. 

 

 

 

When the report opens, format it as 
desired. 

Sample Formatting for Report is 
found in Appendix F, page 61. 

Formatting can be saved as a Macro 
which can be run to automatically 
format future reports. 

Go to Creating a Macro, Appendix F, 
page 57 for instructions. 

Sample Formatting for a Report 

Creating a Macro in MS Word. 

Select a link to go to the Instructions. 
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Section III:  Budget Reports 

The following tables describe the Parameter Values that should be entered for three 
budget reports: 

 FGRBDSC – Budget Status (Current Period) Report 

 FGRODTA – Organization Detail Activity Report 

 FGRGLTA – General Ledger Transaction Activity Report 

An example of each report follows the Parameter Value table. 

FGRBDSC – Budget Status (Current Period) Report 

Description: This report is sorted by fund for each organization.  The report displays: 

 adjusted budget 

 current and year-to-date activity 

 budget reservations 

 available balance for each account 

FGRBDSC Parameter Table 

Parameter 
Number 

Name 
Required 
Yes/No 

Description Value 

01 Fiscal Year Yes Fiscal Year for reporting YY (07) 

02 
Chart of 
Accounts (COA) 

Yes COA for reporting. C 

03 
From Fund 
Code 

Yes (General 
Fund Indexes) 

First Fund Code in a series.  
Indicates first fund code to 
include in the report. 

(as desired) 

04 To Fund Code 
Yes (General 

Fund Indexes) 

Last Fund Code in a series.  
Indicates the last fund code to 
include in the report. 

(as desired) 

05 
From 
Organization 

Yes (Revenue 
Indexes) 

First Organization Code in a 
series.  Indicates the first 
organization code to include in 
the report. 

(as desired) 

06 To Organization 
Yes (Revenue 

Indexes) 

Last Organization Code in a 
series.  Indicates the last 
organization code to include in 
the report. 

(as desired) 
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07 From Account No 
First Account Code in a series.  
Indicates first account code to 
include in the report. 

Normally 
Blank 

08 To Account No 
Last Account Code in a series.  
Indicates last account code to 
include in the report. 

Normally 
Blank 

09 
As of Date  
(dd-mon-yyyy) 

Yes As of date for the report. 
Default = 
System 
date. 

10 
Include Accrual 
Period 

Yes 
Causes accrual periods to be 
included in the report.  Always 
enter Y. 

Always put 
Y (yes). 

11 
Print Report 
Totals 

Yes 
Causes totals to print on the 
report.  Always enter Y for yes 

Always 
enter Y 
(default 
value). 

12 Print Net Totals Yes 
Causes net totals to print on 
the report. 

Always 
enter Y 
(default 
value). 

13 
Commitment 
Type Indicator 

No 
Determines if 
committed/uncommitted 
budget records are printed. 

Always 
leave blank 
(default 
value). 

 

Hint:  Entering AAAA after the first two letters of the Organization Code in the From 
Organization Code field and ZZZZ after the last two letters of the Organization 
Code in the To Organization Code field returns all Index Codes within an 
organization. 

For Example:  IIAAAA and IIZZZZ 
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Sample of FGRBDSC Report 
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FGRODTA – Organization Detail Activity Report 

Description:  This report is sorted by account and fund within each organization.  The 
report displays: 

 expenses 

 budget and encumbrance detail activity (operating ledgers record budget and 
encumbrance activity) within a specified period 

Specifying a From Date and To Date that are the beginning and ending month dates, 
causes beginning and ending balances to display on this report. 

If these dates are not a month begin or end date, activity displays within the date ranges 
without beginning and ending balances. 

FGRODTA Parameter Table 

Parameter 
Number 

Name 
Required 
Yes/No 

Description Value 

01 Fiscal Year Yes Fiscal Year for reporting YY (07) 

02 
Chart of Accounts 
(COA) 

Yes COA for reporting. C 

03 From Organization No 

First Organization Code in a 
series.  Indicates the first 
organization code to include in 
the report. 

(as desired) 

04 To Organization No 

Last Organization Code in a 
series.  Indicates the last 
organization code to include in 
the report. 

(as desired) 

05 From Fund Code No 
First Fund Code in a series.  
Indicates first fund code to 
include in the report. 

(as desired) 

06 To Fund Code No 
Last Fund Code in a series.  
Indicates the last fund code to 
include in the report. 

(as desired) 

07 From Account No 
First Account Code in a series.  
Indicates first account code to 
include in the report. 

Normally 
Blank 

08 To Account No 
Last Account Code in a series. 
Indicates last account code to 
include in the report. 

Normally 
Blank 
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09 From Date Yes 
The beginning date of 
transactions to be reported.  

Usually enter 
first day of 
month. 

10 To Date Yes 
The ending date of transactions 
to be reported. 

Enter last day 
of month. 

11 
Include Accrual 
Period 

Yes 
Causes accrual period to be 
included in the report. 

Always enter 
Y (default=N). 

12 
Print Organization 
Totals 

Yes 
Causes totals to print on the 
report. 

Always enter 
Y (default 
value). 

13 
Commitment, 
Uncommitted, or 
Both 

Yes 
Enter U for Uncommitted, C for 
Committed, or B for Both 

Always use U 
(default value) 

 

Hint:  Entering AAAA after the first two letters of the Organization Code in the From 
Organization Code field and ZZZZ after the last two letters of the Organization 
Code in the To Organization Code field returns all Index Codes within an 
organization. 

For Example:  IIAAAA and IIZZZZ 
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Sample of FGRODTA Report 
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FGRGLTA – General Ledger Transaction Activity Report 

Description:  This report displays by Fund the following information for General 
Ledger Accounts: 

 beginning and ending balances 

 detail debit and credit activity 

NOTE:  General Ledger accounts have debits, credits, and 
balances. 

 Beginning and ending balances are obtained directly 
from the General Ledger Form (FGITBAL). 

 Debit and credit activity is obtained from the 
Transaction Detail Form (FGIGLAC). 

When a From Date and To Date are specified as a month begin and end date, 
beginning and ending balances display on this report.  Otherwise, activity displays 
within the date ranges without beginning and ending balances.  Balances that are 
opposite an account’s normal balance, (i.e., credit, debit, or zero) are flagged with an 
indicator to the right of the balance. 

FGRGLTA Parameter Table 

Parameter 
Number 

Name Required Description Value 

01 Fiscal Year Yes Fiscal year for reporting YY (08) 

02 Chart of Accounts Yes Chart of accounts for reporting. C 

03 From Fund Code No 
First Fund Code in a series.  
Indicates first fund code to 
include in the report. 

(as desired) 

04 To Fund Code No 
Last Fund Code in a series.  
Indicates the last fund code to 
include in the report. 

Normally 
Blank 

05 
From Account 
Code 

No 
First Account Code in a series.  
Indicates first account code to 
include in the report. 

Normally 
Blank 

06 To Account Code No 
Last Account Code in a series. 
Indicates last account code to 
include in the report. 

(as desired) 

07 From Date Yes 
The beginning date of 
transactions to be reported.  

dd-mon-yyyy 

08 To Date Yes 
The ending date of transactions 
to be reported. 

dd-mon-yyyy 
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09 
Include Accrual for 
Last Period 

No 
Causes accrual period to be 
included in the report. 

Always use Y 
(default = N) 

10 Print Fund Totals Yes 
Causes totals to print on the 
report. 

Always use Y 
(default 
value) 

 

 

Sample of FGRGLTA Report 
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Report Printing Tips 

 Always use the first day of a month and the last day of a month in the From Date 
and To Date parameter fields. 

o Causes totals for the Account Code(s) to appear on the printed report. 

 

 If the actual report date is prior to the end of the month: 

o the ending date in the report heading in Word (or after the report is 
printed) should be changed to the actual report date 

o this is to correct the heading date to match the time period covered in the 
report 

 

 Year end reports - printing procedures: 

o Run prior fiscal year reports well after June 30th 

 Business Office continues to post transactions and adjustments to 
Banner indexes until closeout. 

 Final closeout occurs after the annual audit in late September or 
October. 

o When generating a report after June 30th for the prior fiscal year: 

 put a Y in the Include Accrual for last Period parameter field 

 causes report to include post year-end adjustments and to reflect 
final prior fiscal year balances 

 Ensure that the To Date parameter is June 30, 20XX (the last day 
of the fiscal year). 

1.  

Further questions or clarification contact: 

 SLCC Budget Office 

o Dana Van Dyke  – 4149 

o Arlene Asay  – 4229 

o Hoa Nguyen  – 4243 
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Appendix A:  Index Code Logic 

This appendix details the logic behind Index Codes.  Index Codes simplify accounting.  
Each Index Code equals a default: Fund, Organization, and Program Code.  There 
are two types of Index Codes: 

 a six character Alpha code for General Fund (hard funded) Indexes 

 a five digit Numeric code for Revenue (soft funded) Indexes 

Basic Rules: 

General Fund Indexes (hard funded indexes) 

 Rule:  The Index Code matches the 6 letter Organization Code. 

Example: Organization Code Index Code 

Academic Computing IIADCM IIADCM 

 

Revenue Indexes (soft funded indexes) 

 Rule:  The Index Code matches the 5 digit Fund Code. 

Example: Fund Code Index Code 

SEOG 20311 20311 

 

 Exception:  Where one Fund or revenue source has sub funds, the Index Code 
is based on a sequential number series starting with the related 5 digit Fund 
Code. 

Example: Fund Code Index Code 

Grand Theatre Control 16000 16000 

Production #1 16000 16001 

Production #2 16000 16002 

Production #3 16000 16003 
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Appendix B:  Account Code logic 

The following table explains the logic for generating Account Codes. 

Type of 
Code 

Sequence Account Type 

 1XXXX Assets 

 2XXXX Liabilities 

 3XXXX Control Accounts 

 4XXXX Fund Balance/Equity Accounts 

R 5XXXX Revenue Accounts 

L 60XXX Salaries 

L 61XXX Hourly Teaching 

L 62XXX Hourly Non-Teaching 

L 65XXX Salaried Benefits 

L 66XXX Hourly Benefits 

E 7XXXX Current Expense 

T 8XXXX Transfers In and Out 

E 90XXX Travel 

E 94XXX Plant Fund Capital Expenditures 

E 96XXX Budget Hold 

E 99XXX Indirect Costs 

 R = Revenue 
 L = Labor 
 E = Expenditure 
 T = Transfer 
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Appendix C – Accounts for Chart of Accounts 

Revised February 2008 

Accounts In Numeric Order Accounts In Alphabetic Order 

Account 
Number 

Account Description 
Account 
Number 

Account Description 

CURRENT EXPENSE CURRENT EXPENSE 

70010 Data Process Expense 70405 Advertising 

70020 Software/Computer 70610 Awards 

70030 IT Security 70410 Bad Debt Expense 

70110 Materials-Signs 70415 Bank Service Charges 

70120 Materials-Remodeling 70910 Bldg Repair/Maintenance 

70130 Materials-Other 70420 Books & Publications 

70210 Fees-Other 70425 Club Expenditures 

70220 Inspection Fees 76010 Computer Equipment 

70230 License Fees 73510 Conference Registration/Fees 

70240 Memberships 70430 Consignment Payments 

70250 Parking Fees 70431 Contract Retention 

70260 Student Fees 70432 Contributions 

70305 Library-Blank Audio-Video Tapes 70435 Credit Card Charges 

70310 Library-Books/Continuation 70440 Current Exp/Match/Transfer 

70315 Library-Books/Publications 70010 Data Process Expense 

70320 Library-CD Services 70830 Equipment Lease/Purchase 

70325 Library-Materials 70920 Equipment Repair/Maintenance 

70330 Library-Microfilm Services 70445 Expenses Not Classified 

70335 Library-Newspapers 70840 Facilities Lease/Purchase 

70340 Library-On Line Services 70210 Fees-Other 

70345 Library-Rec Audio/Video Tapes 74015 Heat Other 

70350 Library-Recorded CD's 74010 Heat/Gas 

70405 Advertising 70620 Honorariums-1099 

70410 Bad Debt Expense 70220 Inspection Fees 

70415 Bank Service Charges 70450 Insurance 

70420 Books & Publications 70030 IT Security 

70425 Club Expenditures 70305 Library-Blank Audio-Video Tapes 

70430 Consignment Payments 70310 Library-Books/Continuation 

70431 Contract Retention 70315 Library-Books/Publications 

70432 Contributions 70320 Library-CD Services 
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Accounts In Numeric Order Accounts In Alphabetic Order 

Account 
Number 

Account Description 
Account 
Number 

Account Description 

70435 Credit Card Charges 70325 Library-Materials 

70440 Current Exp/Match/Transfer 70330 Library-Microfilm Services 

70445 Expenses Not Classified 70335 Library-Newspapers 

70450 Insurance 70340 Library-On Line Services 

70455 Luncheon & Refreshments 70345 Library-Rec Audio/Video Tapes 

70460 Minor Equipment 70350 Library-Recorded CD's 

70463 Overhead Allocation 70230 License Fees 

70465 Postage and Mailing 70455 Luncheon & Refreshments 

70470 Principle & Interest Cancellation 70130 Materials-Other 

70475 Printing-External 70120 Materials-Remodeling 

70480 Purchase Card 70110 Materials-Signs 

70485 Rcrd Aud/Video Tapes/CD's 70240 Memberships 

70490 Royalties 70460 Minor Equipment 

70495 Subscriptions 70463 Overhead Allocation 

70497 Subsistence - CRO Participants 70250 Parking Fees 

70510 Purchases for Resale-Books 70465 Postage and Mailing 

70520 Purchases for Resale-Food 74020 Power and Light 

70530 Purchases for Resale-Freight 70470 Principle & Interest Cancellation 

70540 Purchases for Resale-Inventory Adjstmnt 70475 Printing-External 

70550 Purchases for Resale-Merchandise 70480 Purchase Card 

70560 Purchases for Resale-Other 70510 Purchases for Resale-Books 

70610 Awards 70520 Purchases for Resale-Food 

70620 Honorariums-1099 70530 Purchases for Resale-Freight 

70710 Refund-Current Expense 70540 Purchases for Resale-Inventory Adjstmnt 

70715 Refund from Foundation 70550 Purchases for Resale-Merchandise 

70720 Refund-Lab Fees 70560 Purchases for Resale-Other 

70730 Tuition Reimbursement (Prior Year) 70485 Rcrd Aud/Video Tapes/CD's 

70740 Student Aid  (Prior Year) 70715 Refund from Foundation 

70750 Reimb-Cell Phone Monthly Charges 70710 Refund-Current Expense 

70755 Reimb-Cell Phone Equipment Charges 70720 Refund-Lab Fees 

70810 Rental of Facilities 70755 Reimb-Cell Phone Equipment Charges 

70820 Rental of Equipment 70750 Reimb-Cell Phone Monthly Charges 

70830 Equipment Lease/Purchase 70820 Rental of Equipment 

70840 Facilities Lease/Purchase 70810 Rental of Facilities 
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Accounts In Numeric Order Accounts In Alphabetic Order 

Account 
Number 

Account Description 
Account 
Number 

Account Description 

70910 Bldg Repair/Maintenance 70490 Royalties 

70920 Equipment Repair/Maintenance 71070 Scholarship-Adjust to FISAP 

70930 Vehicle Maintenance 71110 Scholarship-Board 

70940 Software Maintenance 71120 Scholarship-Books 

71040 Scholarship-Grant-in-Aid 71130 Scholarship-Fees 

71041 Scholarship-Grant-in-Aid Summer 71040 Scholarship-Grant-in-Aid 

71042 Scholarship-Grant-in-Aid Prior Year 71042 Scholarship-Grant-in-Aid Prior Year 

71043 S'ship-Grant Aid Summer Prior Year 71041 Scholarship-Grant-in-Aid Summer 

71045 S'ship-Grant Aid Skill Center 71150 Scholarship-Room 

71046 S'ship-Grant Aid Skills Prior Year 71050 Scholarship-Tier II Waivers 

71050 Scholarship-Tier II Waivers 71052 Scholarship-Tier II Waivers Prior Year 

71052 Scholarship-Tier II Waivers Prior Year 71060 Scholarship-Tuition 

71060 Scholarship-Tuition 72010 Serv Ctr-Bookstore 

71070 Scholarship-Adjust to FISAP 72020 Serv Ctr-CE Computer Lab 

71110 Scholarship-Board 72030 Serv Ctr-Cell Phones 

71120 Scholarship-Books 72040 Serv Ctr-Central Repair 

71130 Scholarship-Fees 72050 Serv Ctr-Copy Center 

71150 Scholarship-Room 72060 Serv Ctr-Distance Education 

72010 Serv Ctr-Bookstore 72070 Serv Ctr-Electrical 

72020 Serv Ctr-CE Computer Lab 72080 Serv Ctr-Food Service 

72030 Serv Ctr-Cell Phones 72090 Serv Ctr-Health Services 

72040 Serv Ctr-Central Repair 72190 Serv Ctr-ID Cards 

72050 Serv Ctr-Copy Center 72100 Serv Ctr-Instructional Media 

72060 Serv Ctr-Distance Education 72110 Serv Ctr-Mailing 

72070 Serv Ctr-Electrical 72120 Serv Ctr-Materials Distribution 

72080 Serv Ctr-Food Service 72130 Serv Ctr-Network Services 

72090 Serv Ctr-Health Services 72140 Serv Ctr-Office Supply (Flow-Thru) 

72100 Serv Ctr-Instructional Media 72150 Serv Ctr-Other 

72110 Serv Ctr-Mailing 72180 Serv Ctr-Security Service 

72120 Serv Ctr-Materials Distribution 72160 Serv Ctr-SLCC Netlink 

72130 Serv Ctr-Network Services 72170 Serv Ctr-Telephone 

72140 Serv Ctr-Office Supply (Flow-Thru) 72174 Serv Ctr-Telephone-Cellular 

72150 Serv Ctr-Other 72171 Serv Ctr-Telephone-Circuits 

72160 Serv Ctr-SLCC Netlink 72172 Serv Ctr-Telephone-LD 
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Accounts In Numeric Order Accounts In Alphabetic Order 

Account 
Number 

Account Description 
Account 
Number 

Account Description 

72170 Serv Ctr-Telephone 72173 Serv Ctr-Telephone-Paging 

72171 Serv Ctr-Telephone-Circuits 72510 Services-Consulting/Profess Fees 

72172 Serv Ctr-Telephone-LD 72520 Services-Corporation 

72173 Serv Ctr-Telephone-Paging 72525 Services-CRO Participant Stipends 

72174 Serv Ctr-Telephone-Cellular 72530 Services-Individual-1099 

72180 Serv Ctr-Security Service 72540 Services-Interpreting 

72190 Serv Ctr-ID Cards 72550 Services-Laundry/Linen 

72510 Services-Consulting/Profess Fees 72560 Services-Security Alarm 

72520 Services-Corporation 72570 Services-Temporary Staffing 

72525 Services-CRO Participant Stipends 72580 Services-W/C Noncollege Employees 

72530 Services-Individual-1099 70940 Software Maintenance 

72540 Services-Interpreting 70020 Software/Computer 

72550 Services-Laundry/Linen 71045 S'ship-Grant Aid Skill Center 

72560 Services-Security Alarm 71046 S'ship-Grant Aid Skills Prior Year 

72570 Services-Temporary Staffing 71043 S'ship-Grant Aid Summer Prior Year 

72580 Services-W/C Noncollege Employees 73520 Staff Development 

73010 Supplies-Custodial 73565 Stipend - Career Ladder 

73020 Supplies-First Aid/Safety 73570 Stipend - Child Dev Assoc Scholarship 

73030 Supplies-Gas, Oil, Grease, Solvent 73550 Stipend - Early Childhood 

73040 Supplies-Grounds maintenance 73540 Stipend - School Age Care 

73050 Supplies-Instructional 73530 Stipend - Training 

73060 Supplies-Kitchen 73560 Stipend - Training & Longevity 

73070 Supplies-Office  70740 Student Aid  (Prior Year) 

73080 Supplies-Patron Supplies 70260 Student Fees 

73090 Supplies-Photo 73525 Student Travel/Training 

73100 Supplies-Recreation 75020 Subcontract-6 CO AOG 

73110 Supplies-Theater 75010 Subcontract-Add'l Pay 

73120 Supplies-Tools 75030 Subcontract-Bear River 

73510 Conference Registration/Fees 75170 Subcontract-BYU 

73520 Staff Development 75040 Subcontract-CEU 

73525 Student Travel/Training 75190 Subcontract-CEU-San Juan 

73530 Stipend - Training 75050 Subcontract-Dixie 

73540 Stipend - School Age Care 75200 Subcontract-Granite School District 

73550 Stipend - Early Childhood 75060 Subcontract-Moab 
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Accounts In Numeric Order Accounts In Alphabetic Order 

Account 
Number 

Account Description 
Account 
Number 

Account Description 

73560 Stipend - Training & Longevity 75220 Subcontract-Salt Lake County DCR 

73565 Stipend - Career Ladder 75210 Subcontract-Salt Lake School District 

73570 Stipend - Child Dev Assoc Scholarship 75230 Subcontract-Salt Lake/Tooele ATC 

74010 Heat/Gas 75065 Subcontract-SE ATC 

74015 Heat Other 75070 Subcontract-SEUAOG 

74020 Power and Light 75080 Subcontract-Snow 

74030 Telephone 75090 Subcontract-SUU 

74031 Telephone - Circuits 75100 Subcontract-U of U 

74032 Telephone - Long Distance 75110 Subcontract-UCCD 

74033 Telephone - Paging 75120 Subcontract-Uintah 

74034 Telephone - Cellular 75130 Subcontract-USU 

74040 Waste Removal 75140 Subcontract-UT TFC 

74050 Water and Sewer 75150 Subcontract-UVSC 

75010 Subcontract-Add'l Pay 75160 Subcontract-Weber 

75020 Subcontract-6 CO AOG 75180 Subcontract-Westminster 

75030 Subcontract-Bear River 70495 Subscriptions 

75040 Subcontract-CEU 70497 Subsistence - CRO Participants 

75050 Subcontract-Dixie 73010 Supplies-Custodial 

75060 Subcontract-Moab 73020 Supplies-First Aid/Safety 

75065 Subcontract-SE ATC 73030 Supplies-Gas, Oil, Grease, Solvent 

75070 Subcontract-SEUAOG 73040 Supplies-Grounds maintenance 

75080 Subcontract-Snow 73050 Supplies-Instructional 

75090 Subcontract-SUU 73060 Supplies-Kitchen 

75100 Subcontract-U of U 73070 Supplies-Office  

75110 Subcontract-UCCD 73080 Supplies-Patron Supplies 

75120 Subcontract-Uintah 73090 Supplies-Photo 

75130 Subcontract-USU 73100 Supplies-Recreation 

75140 Subcontract-UT TFC 73110 Supplies-Theater 

75150 Subcontract-UVSC 73120 Supplies-Tools 

75160 Subcontract-Weber 74030 Telephone 

75170 Subcontract-BYU 74034 Telephone - Cellular 

75180 Subcontract-Westminster 74031 Telephone - Circuits 

75190 Subcontract-CEU-San Juan 74032 Telephone - Long Distance 

75200 Subcontract-Granite School District 74033 Telephone - Paging 
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Accounts In Numeric Order Accounts In Alphabetic Order 

Account 
Number 

Account Description 
Account 
Number 

Account Description 

75210 Subcontract-Salt Lake School District 70730 Tuition Reimbursement (Prior Year) 

75220 Subcontract-Salt Lake County DCR 70930 Vehicle Maintenance 

75230 Subcontract-Salt Lake/Tooele ATC 74040 Waste Removal 

76010 Computer Equipment 74050 Water and Sewer 

    

TRAVEL TRAVEL 

90010 Staff In-State Dev 90440 Ath Recruit-Entertainmt 

90020 Faculty In-State Dev 90420 Ath Recruit-Lodging 

90025 Budget Center Manager In-State Dev 90430 Ath Recruit-Meals 

90030 Staff In-State Other 90410 Ath Recruit-Travel 

90040 Faculty In-State Other 90350 Ath Trav-Athletic Director 

90045 Budget Center Manager In-State Other 90320 Ath Trav-Lodging 

90050 In-State Recruitment 90330 Ath Trav-Meals 

90060 Motor pool 90340 Ath Trav-Misc 

90065 Student In-State Travel 90310 Ath Trav-Transportation 

90110 Staff Out-State Dev 90190 Budget Cntr Mngr International Dev 

90120 Faculty Out-State Dev 90195 Budget Cntr Mnger International Other 

90125 Budget Center Manager Out-State Dev 90025 Budget Center Manager In-State Dev 

90130 Staff Out-State Other 90045 Budget Center Manager In-State Other 

90140 Faculty Out-State Other 90125 Budget Center Manager Out-State Dev 

90145 Budget Center Manager Out-State Other 90145 Budget Center Manager Out-State Other 

90150 Out-State Recruitment 90155 Cash Advance Flow-Thru 

90155 Cash Advance Flow-Thru 90020 Faculty In-State Dev 

90165 Student Out-State Travel 90040 Faculty In-State Other 

90170 Staff International Development 90175 Faculty International Development 

90175 Faculty International Development 90185 Faculty International Other 

90180 Staff International Other 90120 Faculty Out-State Dev 

90185 Faculty International Other 90140 Faculty Out-State Other 

90190 Budget Cntr. Manager International Dev 90050 In-State Recruitment 

90195 Budget Cntr. Manager International Other 90060 Motorpool 

90210 Team Trav-Transportation 90150 Out-State Recruitment 

90220 Team Trav-Lodging 90010 Staff In-State Dev 

90230 Team Trav-Meals 90030 Staff In-State Other 

90240 Team Trav-Misc 90170 Staff International Development 
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Accounts In Numeric Order Accounts In Alphabetic Order 

Account 
Number 

Account Description 
Account 
Number 

Account Description 

90310 Ath Trav-Transportation 90180 Staff International Other 

90320 Ath Trav-Lodging 90110 Staff Out-State Dev 

90330 Ath Trav-Meals 90130 Staff Out-State Other 

90340 Ath Trav-Misc 90065 Student In-State Travel 

90350 Ath Trav-Athletic Director 90165 Student Out-State Travel 

90410 Ath Recruit-Travel 90220 Team Trav-Lodging 

90420 Ath Recruit-Lodging 90230 Team Trav-Meals 

90430 Ath Recruit-Meals 90240 Team Trav-Misc 

90440 Ath Recruit-Entertainmt 90210 Team Trav-Transportation 

    

CAPITAL PURCHASES ($5000 or More) CAPITAL PURCHASES ($5000 or More) 

94010 Office Furniture and Equipment  94030 Audio/Visual Equipment  

94020 Instructional/Sports Equipment  94055 Capital Software  

94030 Audio/Visual Equipment  94045 Computer Equipment  

94040 Physical Plant Equipment  94050 Data Processing Equipment  

94045 Computer Equipment  94020 Instructional/Sports Equipment  

94050 Data Processing Equipment  94070 Motor Vehicles  

94055 Capital Software  94010 Office Furniture and Equipment  

94060 Other Equipment  94060 Other Equipment  

94070 Motor Vehicles  94040 Physical Plant Equipment  
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Appendix D – Banner Form Naming Matrix 

Each Banner Form has a unique Name and Description.  The Form Name contains 7 
letters.  The following matrix is used determine the form name and aid the user in 
identifying the purpose and/or description of a form. 

 

1st Letter 
Identifies the 
Primary 
System 
owning the 
form. 

A  Advancement K  Work Management T  Accounts Receivable 

B  Property Tax 
L  Occupational 
Tax/License 

U  Utilities 

C  Courts N  Position Control V  Voice Response 

D  Cash Drawer O  Customer Contact X  Records Indexing 

E  XtenderSolutions P  HR/Payroll/Personnel W  Reserved for client 
Y   applications that  
Z   co-exist with Banner. F  Finance Q  Electronic Work Queue 

G  General R  Financial Aid 

I  Information Access S  Student 
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2nd Letter 
Identifies the 
Module 
owning the 
form. 

Advancement (A) Financial Aid (R) 
HR/Payroll/Personnel 

(P) 
Position Control (N) 

A  Advancement B  Budgeting A  Application 

D  Designation C  Record Creation B  Budget 

E  Event Management 
E  Electronic Data 
    Exchange 

C  COBRA 

F  Campaign F  Funds Management D  Benefit/Deduction 

G  Pledge and Gift/Pledge 
     Payment 

H  History and Transcripts E  Employee 

J  Student Employment 
H  Time 
Reporting/History 

L  Label L  Logging O  Overall 

M  Prospect Management N  Need Analysis P  General Person 

O  Organization O  Common Functions R  Electronic Approvals 

P  Constituent/Person 
P  Packaging & 
    Disbursements 

S  Security 

S  Solicitor Organization R  Requirements Tracking T  Validation/Rule Table 

T  Validation Form/Table 
S  Student System Shared 
    Data 

U  Utility 

U  Utility T  Validation Form/Table V  Reserved 

V  Reserved U  Utility 
X  Tax Administration 

X  Expected Matching Gift V  Reserved 

Finance (F) General (G) Student (S) 

A  Accounts Payable E  Event Management A  Admissions 

B  Budget Development J  Job Submission C  Catalog 

C  Cost Accounting L  Letter Generation E  Support services 

E  Electronic Data 
     Interchange 

O  Overall 
F  Registration/Fee 
     Assessment 

F  Fixed Assets P  Purge G  General Student 

G  General Ledger S  Security 
H  Grades/Academic 
     History 

I  Investment Management T  Validation Form/Table I  Faculty Load 

N  Endowment 
    Management 

U  Utility 
K  Reserved – SCT 
     International.  UK 

O  Operations V  Reserved L  location Management 

P  Purchasing/Procurement X  Cross Product M  CAPP 

R  Research Accounting Accounts Receivable O  Overall 

S  Stores Inventory 
F  Finance Accounts 
    Receivable 

P  person 

T  Validation Form/Table 
G  General Accounts 
     Receivable 

R  Recruiting 
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U  Utility O  Overall S  Schedule 

V  Reserved R  Research Accounting T  Validation Form/Table 

X  Archive Purge 
S  Student Accounts 
    Receivable 

U  Utility 

Info.  Access/Kiosk (I) T  Validation Form/Table 
V  Reserved – Can. 
     Solution Ctr. 

R U  Utility XtenderSolutions (E) 

S  Student 
V  Reserved – Can. 
    Solutions Ctr. 

T  Validation Form/Table 

X  XtenderSolutions 

All Products 

W  Reserved for client forms or modules used within a Banner application 
X   (character in Letter 1 position does not equal W, Y, or Z) 
Z 

 
  



 

SLCC Banner  

Budget Management Tools in Banner 

Budget Management Tools in Banner   Page 53 
Office of Information Technology  February, 2016 

 

3rd Letter 
Identifies the 
Type of 
form. 

Advancement (A) Financial Aid (R) 
HR/Payroll/Personnel (P) 

   Position Control (N) 

A  Application Form A  Application Form A  Application Form 

B  Base  Table B  Base  Table B  Base  Table 
     Batch COBOL process C  Called/List Form I  Inquiry Form 

I  Inquiry Form P  Process/Report I  Inquiry Form 

P  Process/Report 
R  Rule Table 
    Repeating Rules Table 
    Report 

P  Process/Report 

R  Repeating Rules Table 
R  Rule Table 
    Repeating Rules Table 
    Report/Process 

T  Temporary Table 

V  Validation Form 
     View 

T  Temporary Table 

V  Validation Form/Table 
     View 

V  Validation Form/Table 

Finance (F) General (G) Student (S) 

A  Application Form A  Application Form A  Application Form 

B  Base  Table B  Base  Table 
     Batch COBOL process 

B  Base  Table 

I  Inquiry Form I  Inquiry Form 

M  Maintenance Form I  Inquiry Form P  Process 

Q  Query Form O  Online COBOL Process Q  Query Form 

R  Rule Table 
    Repeating Rules Table 
    Report/Process 

Q  Query Form 
R  Rule Table 
    Repeating Rules Table 
    Report/Process 

R  Rule Table 
    Repeating Rules Table 
    Report/Process 

V  Validation Form/Table 
     View 

V  Validation Form/Table 
     View 

T  General Maintenance 
    Temporary Table Accounts Receivable 

(T) 
Information 

Access/Kiosk (I) 

A  Application Form 

V  Validation Form/Table 
     View 

R  Report 
I  Inquiry Form 

P  Process XtenderSolutions (E) 

Q  Query Form A  Application Form 

R  Report 
V  Validation Form/Table 

V  Validation Form/Table 
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4th, 5th, 6th, and 7th letters:  Abbreviation of the form’s purpose or function. 

 

Example:  Below are 3 Forms and their structure: 

SPAIDEN GJRRPTS FPIREQN 

S Student G General F Finance 

P Person J Job Submission P Procurement 

A Application Form R Report/Process I Inquiry Form 

IDEN Identification RPTS Reports REQN Requisition Query 

 

Return to Table of Contents 
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Appendix E:  Transaction Types and Document 
Number Definitions 

Commonly Encountered Transaction Types 

Type Definition 

ADEI Additional charge (freight, etc.) 

BD01 Permanent or original budget entry 

BD02 Permanent budget entry (Base transfer) 

BD03 Temporary budget entry (one-time transfers) 

CNEC Voided check - Credit memo with encumbrance 

CNEI Voided check - invoice with encumbrance 

CNNC Voided check - Credit memo without encumbrance 

CNNI Voided check - invoice without encumbrance 

CORD Change purchase order 

DCSR 
Cash receipt entry (posts cash received, but not deposited with the Cashier's 

Office) 

E100 Travel encumbrance 

E032 Encumbrance liquidation 

HFNL Payroll benefits 

HGNL Payroll salaries 

ICEC Cancel credit memo with encumbrance 

ICEI Cancel invoice with encumbrance 

ICNC Cancel credit memo without encumbrance 

ICNI Cancel invoice without encumbrance 

IDB Inter-departmental billing 

INEC Credit memo with encumbrance 

INEI Payment of invoice with encumbrance 

INNC Credit memo without encumbrance  

INNI 
Payment of check request invoice (without encumbrance) -"check request 

stamp" 

JE05 Beginning balance posting entry 

JE16 General journal entry (from Business Office) 
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Type Definition 

MIS Cash receipt transaction deposited at Cashier's Office 

PB1 (2or 3) 
Charge to student from the Banner-Student system (i.e. Tuition, student fee or 

lab fee) 

PCLQ Cancel PO - reinstate requisition reservation 

POLQ Liquidation of requisition reservation  (when the purchase order is established) 

PORD Establish purchase order (establishes an encumbrance) 

RCQP Cancel requisition 

REQP Requisition - (establishes a reservation) 

VISA VISA P-card charge 

    

Document Numbers 

Document 

Number 
Definition 

Fxxxxxxxx 
"F" Documents represent a journal entry resulting from a batch or file loaded 

into Banner Finance 

Jxxxxxxxx "J" Documents represent a journal entry entered on-line. 

Ixxxxxxxx "I" documents represent invoices being paid. 

Pxxxxxxxx "P" documents are purchase order transactions. 

Rxxxxxxxx "R" documents represent a purchase requisition. 

Txxxxxxxx "T" documents represent a travel encumbrance. 

 
Return to Table of Contents 
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Appendix F:  Creating Macros in Word 2013 

What is a Macro? 

A Macro automates a task performed repeatedly or on a regular basis.  For example, a 
series of commands and actions (Mouse clicks and key strokes) to format a report can 
be recorded and run to repeat the formatting.  As you format the report, series of 
commands and actions are recorded and saved as a Macro.  The Macro then is run to 
automatically repeat the recorded series of commands and actions. 

In the case of Banner reports, after opening a report in Word, record and save 
formatting commands as a Macro.  Using this Macro, future reports format exactly the 
same way, automatically. 

Tip:  The most important step in creating a Macro is careful planning.  For example, 
determining the formatting steps of a report prior to recording the Macro.  Beginning on 
page 8 are sample formatting steps for a report generated in Banner. 

Instructions for Creating a Macro: 

Step 1 – Display the Marco Recording Button 

In Word 2013, the Macro Recording button can be displayed on the Status Bar.  By 
default, this button is not displayed.  To display the button, do the following: 

1. Right click on a blank 
area of the Status Bar 
(The Status Bar is at the 
bottom of the Word 
window).  This opens the 
Customize Status Bar 
menu. 

2. Click on Macro 
Recording. 

3. This puts a check mark 
by Macro Recording 
and… 

4. Displays the Macro 
Recording button on the 
Status Bar. 
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Step 2 - Create a Record Macro Button 

With the Word document opened, 
click on the Record Macro button. 

 

The Record Macro dialogue box 
opens. 

In the Macro name: field enter a 
name for this macro. 

Note:  This name cannot contain 
spaces. 

In the Assign Macro to area click 
the Toolbar button. 

 

 

The Word Options window opens.  
The Quick Access Tool Bar 
button is selected on the left and 
the Customize the Quick Access 
Toolbar window is on the right. 

 

See the screen shot below: 
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In the left pane, click on 
Normal.NewMacro.(your macro name) 
to select it. 

See #1 above 

Click the Add button. See #2 above 

This will add a button for the Macro to 
the Quick Access Tool Bar list in the left 
pane. 

See #3 above 

Now you can modify the Macro button 
icon and its display name.  Click the 
Modify… button.  This opens the Modify 
Button dialog box. 

See #4 above 
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This will open the Modify Button 
window displaying Icon choices for the 
button. 

1. Select an Icon by clicking on it. 

2. In the Display Name: field enter a 
name such as Banner Report. 
Note:  this name can have spaces. 

3. Click the OK button. 

 

1. The Macro now reflects the chosen 
Icon and Display Name. 

2. Click the OK button at the bottom of 
the Word Options window to save 
the changes. 

 

The new Macro button (#1) is now 
added to the Quick Access Tool Bar. 

Hover your mouse pointer will show the 
Display Name (#2). 
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Step 3 - Begin Recording the Macro 

When the Word Options window closes, the system will begin recording all Mouse and 
Keyboard inputs as a Macro. 

 

This will be indicated by: 

1. When in the body of the document, 
the Mouse Pointer icon changes  to 
a pointer with an attached recording 
cassette. 

2. The Macro Recording button on the 
Status Bar is now a Stop Recording 
button. 

 

After performing the steps to be recorded 
as the macro, click the Stop Recording 
button. 

Note:  The Mouse Pointer will return to 
normal indicating recording has stopped. 

See #2 above 

 

The recorded steps are now saved as a Macro and can repeated automatically in the 
future simply by clicking your macro button in the Quick Access Toolbar. 

 

Sample Formatting for a Banner Budget Report 

With the report opened as a Word 2010 document, the following is a sample of 
formatting that can be saved as a Macro: 

 

Begin the Macro Recording as 
described in 
Step 3 above. 

 

 

 

Format the report as follows:  

1. Select all text by pressing the Ctrl + 
A keys together. 
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2. Select the Home tab and in the Font 
field select Courier New. 

3. In the Pitch Size field select 8. 

 

Select the Page Setup group on the 
Page Layout tab and: 

4. Select Margins. 

5. From the dropdown select Narrow 
(0.5” margins). 

 

6. Select Orientation. 

7. From the dropdown select 
Landscape. 

 

8. On the Status Bar, click the stop 
Macro Recording button. 

The Macro stops recording, your 
mouse pointer returns to normal, and 
your macro is recorded. 

 



 


